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Introduction to the MODx Manager 
 
To login to your site's Manager: 

• Go to your school’s website, then add “/manager/”  
ex. http://alamosa.k12.co.us/school/manager/ 

• Enter your username and password, then click on login 
• Your password is your first initial, last initial, and your first 5 digits (ex. tw12345) 

 
 
To logout – it is important that you do this: 

• In the Admin Menu in the upper right of the page click on: 

 
 
The Manager area is divided into 3 panels  

• Top: Main and Admin Menus 
• Left: Document tree (You can resize the left-hand panel by dragging the middle bar left 

or right.) 
• Right: Editing area 
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The Document Tree 
This is a list of all the pages in your website, arranged in a hierarchical order.  The number in 
parentheses on the right of each document's title is the document ID.  There may be occasions 
when you will need to know a document's ID.  A few of the document tree icons might be 
useful to you. 

 
1. Expand 
2. Collapse 
3. New Document – Don’t Use 
4. New Web Document – Don’t’ Use 
5. Refresh Tree 
6. Sort Tree 
7. Purge Deleted Documents  
8. Hide Tree 

 
Left Click on the Icon in front of a page to see a Context Menu which gives you shortcuts that 
are very useful!  

 
• To create documents and weblinks in your 

existing document, left-click on the icon in front 
of the document and select one of the Create... 
items in the list.  

 
• If the container document had no children before, 

it will automatically be changed to a container 
(folder). 

 
• You can go directly to the Edit page of a 

document, without having to open the document 
first.  

 
• The colors in the tree tell you about your 

document. 
o Red – unpublished 
o Orange – don’t show in menu 
o Green – show in menu 

 
 

 
 



 3

How do I preview my live site? 
Left-click on the icon in front of the page you want to preview.  The bottom option in the menu 
is Preview Document.  This will open that page in a new browser tab. 

 
 
 
Editing WebPages  
To update existing content on the site you need to:  

• Locate the web page (called a document) in the document tree. 
• Click on the document's name and select Edit from the top menu, OR  

left-click the icon next to the document’s name and select "Edit document" 

. 
• Edit the page with the WYSIWYG editor. 
• As you are working, you will want to periodically save your changes: 

o You can change the “After Saving” option to “Continue Editing” if you want to 
keep working on the same page. 

 
• Check your work in the Preview window. 
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To add a new page to your site: 
 
• Left-click on the icon in front of a document to get the Context Menu and choose Create 

Document Here.  (The document you create will be a sub-document to the one you 
clicked on.) 

• Fill in the fields on the General Tab of  the Document Settings 
o You must fill in the Title – the rest you can leave as is. 
o Your template MUST be a Mollio template! 

 

 
 

• Scroll down to the Document Content area and add you content. 
 
• Click Save to save the content.  Change the After Saving option to Continue Editing if 

you wish to keep working on the same page. 
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Unpublishing a page 
When you create a new document it is published by default.  If you are not ready for the page to 
be seen, it can be un-published (ie. cannot be viewed on the front end of the website).  If the 
document is unpublished it will appear in the document tree in red, indicating that it is not yet 
published. 

 
 
To unpublish a new webpage:  

• Left –click on the icon in front of the page in the document tree, and choose Unpublish 
Document 

• For more advanced publishing options – like publish dates, edit the Document and then 
click on the Page Settings tab.  

• You can turn publishing on/off here and set publish/unpublish dates. 

 



 6

Moving WebPages to a New Document Parent 
• Left-click on the icon of the document you want to move and select Move Document 

from the context menu. 

  
 

• The Move Document page will load. 

 
 

• In the document tree, select the document to be the parent/container, then click Save. 
 

 
Verifying the template  
After you create a web page, check that the correct template is attached.  

 
• Edit the document, and go to 

the General tab.  
 

• In the 'Uses template' area, 
Mollio B is the default 
Template.  If you change this, 
it MUST be to another Mollio 
Option.  If you choose 
something else, your site will 
not work correctly 

 
• Click on Save in the Action 

buttons.  
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Note: The following instructions assume that you are using Xihna 
as your WYSIWYG editor.  
 
How do I insert images? 

• Click on .  This opens the Insert Image dialogue box. 

 
 
• Click the Browse Button.  This Opens the Resource Browser dialogue box. 

 
• Very Important!  Click on the folder with your user name on it.  You should see your 

username on the top gray bar! 
• If you see the image you want to insert, click on it – if not you will need to Browse on 

your computer for the image.  
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o Click on Browse and the File Upload Dialogue box will open.  Navigate to find 
the image you want to upload to the ModX server.  (be sure it is .gif, .jpg. or .png 
and optimized for the web -- see tips below)  Click on OK 

 
 

o Back in the Resource Browser, click the Upload button 
 
Image Tips 
You can only use GIF, JPG or PNG images in a web page. 

• You can use most photo-editing software to convert TIF or BMP images to JPG or GIF. I 
recommend you use Irfanview to very easily save as JPG or GIF format and to resize the 
image.  (See next page for directions.) 

• Check that the JPG or GIF images are not too large. You can see the size in the image 
editor. You should look for the width dimensions in pixels (px). 

• If you have multiple images on a page, they should be the same width for design 
consistency. This should not be more than 300px, and in most cases would be between 
100-200px.  

• You can take a JPG screen shot of the image in the PDF document. You can use the free 
screen capture software at wisdom-soft.com. 
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Using IrfranView to Resize images  
 
From the File menu, choose Open and browse to the file you want to work with 
 
From the Image menu, choose 
Resize, 

 Choose 640 x 480 
 Get back into Resize and 

choose half 
 
 
 
 
From the File menu, choose 
SAVE AS 

 Change the filename to 
something meaningful 

 Change the Save as Type to 
JPG 

 

 
 
Now you will need to switch to ModX, choose the picture tool and upload this new 
picture into your ModX picture folder.  (Be sure to click on the folder with your name on 
it.!!!!! 
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How do I insert a link? 
To insert a link to another website or to a document: 

• Select the text or image that you want to link from. 

• Click on  
• The following dialogue box appears  

 
• To link to an external web site, copy the URL from another browser tab and paste into the 

URL box.   
o You can use Right-Click copy & paste or the keyboard shortcuts Ctrl C (copy) 

and Ctrl V (paste). 
o Most external web sites should be set with the Target going to a new window  

• To link to an internal page, you will need to enter this text:  index.php?id=# and replace 
the number sign with the Document ID found in the Document Tree.  

• After you click OK, the link will appear in the content editor as blue underline text. 
However on the front-end of the website the links will maroon.  

 
How do I insert links to a pdf or word document? 

• Select the text that you want to link from.  We recommend that you always put the .pdf., 
doc or other extension on the end so that user will know that the link leads to a document, 
not another page. (eg. Policies.doc) 

• Click on the icon 
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• Click on the Browse button. 
• Click the Browse Button.  This Opens the Resource Browser dialogue box. 

  
• Very Important!  Click on the folder with your user name on it.  You should see your 

username on the top gray bar! 
• If you see the file you want to insert, click on it – if not you will need to Browse on your 

computer for the file.  
o Click on Browse and the File Upload Dialogue box will open.  Navigate to My 

Documents and find the file you want to upload to the ModX server.  Click on 
OK 

 
 

• Back in the Resource Browser, click the Upload button, then click on the file, and then  
click on OK. 
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How to use the WYSIWYG editor  
The editor is similar to using MS Word. However there are a few crucial things to remember 
when working with an HTML editor online.  

• Save you work often! You WILL remember to do this after you have lost a substantial 
amount of formatted text because the admin area has timed-out or your internet 
connection drops.  

• Don’t assume what you copy and paste from MS Word will show up correctly on a 
web site.  

o It is recommended that you first copy any text to WordPad or another plain-text 
editor, then copy the text into the editor.  

 
Important:  Cut, Copy, Paste – Not on the toolbar.  Learn and use standard keyboard 
shortcuts. 

• Cut = Ctrl X 
• Copy = Ctrl C 
• Paste = Ctrl V 

 
There are a number of buttons on the editor's toolbar.  Depending on your site configuration, you 
may see more or fewer buttons on your editor's toolbar. 
 
Roll your mouse over the icons to see tooltips. Some tips are provided below. 

 
• Format – Choose between Normal or Heading Levels which will give you a horizontal 

rule under your text .  (Don’t use Headings 4, 5 or 6) 
• Font – The default font is Arial.  Avoid changing the fonts as you will lose consistent 

design in your site.   
• Font size – The default font size is 10.  You might want to increase the font size to 12.  

Avoid applying lots of different sizes to your fonts and avoid using really large font sizes. 
• Bold, Italic, Underline, Strikethrough - all self-explanatory.  Avoid underlining your 

content, as your visitors will presume that the underlined text is a link! 
• Font color, Background color & Current Style – Allows you to change your font color 

or the background of the selected text.  This will NOT change the color of the entire 
background of your document area.  The Current Style is really not useful.  It just shows 
the formatting you have applied to the selection.  

• Superscript/Subscript – self-explanatory – effects your highlighted text. 
• Text justifications – Left, Center, Right & Full Justification:  Use the Center Align 

button instead of using spaces to move your text to the center.  
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• Lists: number and unordered - are powerful and useful tools for formatting content. 

Avoid using nested lists.  They just don’t look good on a web site.  You are limited in 
how the bullets will look, but Xihna does give you choice for your numbered lists.  

• Increase & Decrease Indent - Use instead of hitting the space bar a bunch of times to 
move text in.  Useful for positioning text such as quotes, or positioning images off the 
margins.  Make sure that you Preview the changes, as in some designs Indenting text may 
have unforeseen consequences on other aspect of the design. 

• Horizontal Rule - insert a horizontal rule. These can be styled by your web designer 
using CSS. 

• Character Map - insert special characters like © and ¾ . 
• Links - used to insert internal and external links (see FAQ below). 
• Anchors – allows you to set an anchor within a page for linking from one place in a page 

to another place in the page. 
• Images - used to upload and insert images (see FAQ below). 
• Tables - used to insert and modify tables. 
• Undo & Redo – self-explanatory 
• Select All – self-explanatory 
• Print Document – not sure if this works within ModX 

 

 
• Clean up HTML --  
• Paste as Plain Text - If you must copy from MS Word, use this. It gets rid of all your 

formatting – you will have to reformat text.  But in the long run, you will be much 
happier. 

• Clear inline font specifications – removes font formatting 
• Remove Format - can be a little inconsistent, but in general, removes all formatting from 

the selected text. 
• Split block – separates your tables 
• Direction Left to Right/Right to Left – basically is another way to left or right align 

text. 
• Toggle HTML – shows the html code version, lets you work in code if you need. 
• Help using Xihna – shows keyboard shortcuts 
• Info on Xihna – Ignore – no value to you 
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• Insert Smiley – Lots of choices.  Use sparingly. 
• Insert Scrolling Marquee – Doesn’t work – don’t use 
• Maximize/Minimize Editor – Really great feature.  Lets you maximize the document 

content area to fill up the entire right side of you screen.  Keeps the menu’s stationary at 
the top of the window. 

• Find, Replace – search for text and replace it with something else.  Ex. Find he and 
replace with he/she. 

 
Tables 
 
It is best to insert a table in Xihna, but editing the table in Xihna is difficult.  Here is what 
Xihna has to offer. 
 

   
 

• Table Properties – Don’t use – switch to the FCKEditor instead 
• Row Properties – Don’t use – switch to the FCKEditor instead 
• Insert Row Before -  
• Insert Row After-  
• Delete Row -  
• Split Row – Doesn’t work 
• Insert Column Before -  
• Insert Column After-  
• Delete Column -  
• Split Column – Doesn’t work 
• Cell Properties - Don’t use – switch to the FCKEditor instead 
• Insert Cell Above -  
• Insert Cell Below -  
• Delete Cell -  
• Merge Cells -  
• Split Cell – Doesn’t work 
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Can I copy directly from Word?  
Yes, but!  This is the most common mistake with editing—Word puts lots of junky codes into 
your text which do not look right on a webpage.  Have you run across web pages with these � in 
them.  This is a Word problem.  It is recommended that you copy text from Word into WordPad 

before copying into the html editor. If you do paste from Word, use the button. 
 
 
Why is my text double spaced in the editor when it was single spaced in Word? 
In HTML formatting, a paragraph marker leaves a blank line between lines of text.  You can 
remove extra line-breaks by using Delete on the previous line.  Sometimes you have to play with 
using both the Delete and the Backspace keys to remove extra lines. 
 
How do I use heading styles in the WYSIWYG editor?  
You should use the Format dropdown to style your text. 

 
• Select the text you want to style. 
• Select the style you want to apply from the style dropdown.  
• To reset to standard text, select Normal. If a style is not changing, try toggling it to 

another style and back again. 
• Do not sue Heading 4, 5 or 6 – they are too small and difficult to read. 

 
 


